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Changing the Style 
To change to a different styles 

1.  Click on the name of the active style to open the list of available styles 

2.  Select the style you wish to open by clicking on it 

3.  The style will load—this may take a few seconds depending on the num‐
ber of color swatches in each style 

 

Categories 
Each style is divided into logical categories of swatches to make it easy to find 
what you need. To switch between them, click on the category name.  A panel 
of thumbnails of the swatches for the category selected will appear. 

 

Color Swatches 
Each category contains a number of appropriate swatches for coloring objects 
that fit into the category.  Any category can have an unlimited number of 
swatches, with nine thumbnails visible at one time.  Use the scroll bar to scroll 
through the available swatches.  Once a swatch is selected a larger preview 
will appear below the thumbnails. 

There are two basic types of swatches: Tiled and non‐tiled 

Tiled:  These swatches are repeating patterns used mainly for coloring large 
areas such as turf, mulch, pavers etc.  These swatches repeat a pattern to fill an 
area. 

Non-Tiled:  These are non‐repeating swatches that will stretch to fill the area 
they are inserted into.  For example, all the tree, shrub and perennial swatches 
are non‐tiled swatches (except groundcovers). 

Figure  14—Categories and swatches 

Coloring Objects 
 

Coloring objects in DS|Color is very simple.  
To color an object (figure or area) follow 
these steps: 

1.  Select the color swatch you wish to 
use. 

2.  Move your mouse over to the object 
you wish to apply the color to.  Your 
cursor will look like a paint brush. 

3.  As you move your mouse over the 
presentation, the perimeter of objects 
that can be colored will highlight blue. 

4.  Click inside the blue highlighted object 
and the color will immediately be 
applied to it. 

Figure 15—Applying color to an object 
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Understanding the Layering Order 
As you begin applying color to your presentation you may notice that it may appear as if some objects cannot be 
selected.  This could be for a number of reasons.  One reason could be the layering order of objects on the presenta‐
tion.  The layering order in DS|Color works different than DS|Design but very similar to most graphic programs. 

 
 

What does layering order mean?  
Layering order means that overlapping objects on the presenta‐
tion are either on top or below each other, each sitting on their 
own ‘layer’.  Without color applied to them, they all appear to be 
on the same layer but they are not.  It is not until color is ap‐
plied, or attempted to be applied, that it becomes apparent. 

 

 

 
How is the layering order determined? 
The original layering order is determined by the sequence in which objects were drawn in DS|Design.  For exam‐
ple, if the last thing you drew in Design was the outline of your plant bed, then the entire area inside the shape 
drawn is on the top layer.  This means that when you try to apply color to plants or rocks inside the plant bed, the 
only object that will select will be the plant bed.  In order to select the objects ‘under’ the plant bed, the plant bed 
would need be to ‘moved’ to a layer ‘behind’ the objects to be colored. Each object on the presentation is on its own 
layer. 

 

How do you change the layering order of objects? 
To change the layering order of objects in DS|Color you can use one of the four layering tools found on the toolbar. 
To use them: 

1.  Click on one of the layering tools 

2.  Click once on the object you wish to 
move forward or backward. 

Since a presentation can have many 
objects on it, using the tools that move 
one layer forward or backward may 
not produce noticeable changes.   
 

As a result, you will find that using the tools that move objects to the front or to the background will give the 
best results.   

Figure 16—Objects and the layering order  

How to tell if an object has changed layers 
Until color is applied, changes made to the order of objects is not obvious.  Without any color applied, 
the only way to tell if an object is behind another object is if it cannot be selected.  Move the front objects 
to the background layer in order to color objects beneath them. 
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Helpful tips for the coloring process 
 

1. Color background objects first 
You will find it easier to color background objects such as lawn, plant beds and hardscape surfaces first (see figure 
17).  The areas that define these objects will most often appear on the top layering order because the outlines of 
these areas were the last objects drawn in Design.  Objects drawn last will appear on the front layers, on top of 
most of your figures.   

Figure 17 ‐  Coloring background objects first 

2. Use the layering order tools 
Once the background objects are colored, send them to the background layer so that foreground objects can now be 
colored.  You will find that the tool that moves objects to the background layer to be the most useful of the layering 
tools.  Choose the objects that you wish to end up on the top and send them to the background first.  Send objects 
you wish to be on the bottom layer last so that they end up underneath everything.  As you work on coloring the 
remaining objects you may need to revise the order of objects to get the best results. 
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Removing Areas Drawn with the DS|Color Tools 
Areas drawn with either of the color drawing tools can be removed by using the undo button or by using 
the Remove Fill tool.  The remove fill tool will remove any color in the drawn area as well as the polygon 
or circle from the presentation.  It will only remove the color (and drop shadow) from figures and areas 
that were drawn in DS|Design, leaving the original object. 

Using the Drawing Tools to Create Areas for Color 
There are two drawing tools in DS|Color that can be used to create shapes that can be colored.  These can be used 
to add additional detail to the presentation or to create an outline for an area that was not set up for color in 
DS|Design. 

 

 

 

The Circle Drawing Tool 
The first drawing tool is the circle tool.  It works very similar to the circle tool in Design in that you first select the 
origin of the circle (center point) and then the perimeter (radius).  The circle drawn will be defined by a grey 
dashed line.  This grey dashed line may disappear from view when printing or when working on other areas 
within the  presentation.  When you mouse over to apply color to it the circle will appear as a solid blue line.  Color 
is applied in the same way as any other object in the presentation.  
 

The Polygon Drawing Tool 
The second drawing tool is the polygon tool.  It allows you to create a polygon consisting of as many line segments 
as you choose.  Begin by clicking around the area you wish to fill with color and end with a right‐click.  While 
clicking around the area you can use the [Delete] key on your keyboard to remove the last segment.  The polygon 
drawn will be defined by a grey dashed line.  This grey dashed line may disappear from view when printing or 
when working on other areas within the  presentation.  When attempting to apply color to it, the polygon will ap‐
pear as a solid blue line.  Color is applied in the same way as any other object in the presentation.  

Figure 18—Using the drawing tools 
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To make changes to the appearance of colored objects on your drawing, select the Edit Properties tool 
and then select the object you wish to change.  A thumbnail of the swatch from the selected object will 
appear on the left panel along with the accompanying fill settings.  Objects that have been colored with 
‘tiled’ swatches such as paving stone, flagstone, mulch etc. will have an additional Scale setting. 

Editing Colored Objects 
As you apply color to the presentation there are a number of editing options that can be used to change the appear‐
ance of  colored objects: 

� Adjust Opacity, Rotation, Scale and Bleed 

� Copy the properties of swatch (adjusted or unadjusted) to another object 

� Apply Shadows 

 
Using the Edit Fill Tool to adjust Opacity, Rotation, Scale and Bleed 

Figure 20—Tiled Fill Settings 

Figure 19—Non‐tiled Fill Settings 

How to Change a fill 
setting 
There are two ways to change the 
value of a fill setting: 

1.  Left‐click on the slider button 
and drag it to change the value 

  or 

2.  Highlight the value number,  
type in a new value and press 
[Enter] 

Revising your Design (NEW for v2.0) 
If you have spent time coloring a drawing but realize you have forgotten to create a 
closed area or you need to revise something on your original DS|Design drawing, 
you do not have to start over. DS|Color v2 has a Drawing Update feature that 
allows you to make changes to your DS|Design drawing and then update your 
DS|Color presentation, even after you have colored it entirely. 

To update your DS|Color file follow these steps: 

1.  Locate your original DS|Design drawing and make the changes needed. Save 
the drawing. 

2.  In DS|Color, go to the File menu and select Update  Presentation.  

3.  Locate the DS|Design drawing and click Open. 

4.  In the panel that appears, click Yes to continue. Your presentation will update  
based on the changes you made in the DS|Design drawing, maintaining color 
for all areas or figures that have not changed. 
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Changing Opacity 
Reducing the opacity value of a colored object increases the transparency and visibility of objects underneath. The 
default setting for opacity is 100%.  This means that the object is not transparent at all and that objects underneath 
cannot be seen through it.  The images below show the effects of changing the opacity value. 

 

Figure 21—The effects of changing opacity 

100% 75% 50% 

Figure 24—The effects of changing bleed  

Figure 23—The effects of changing scale  

Changing Bleed 
Bleed is used to make colored presentations look 
less ‘perfect’ and more like hand rendering where 
the color spills out over the edges of the objects. 
Use the slider button to adjust the bleed as de‐
sired. 

Changing Scale 
The changing scale option is only available when 
selecting a tiled swatch for editing.  Most tiled 
swatches are inserted at a default scale the is ap‐
propriate for most presentations.  If you find that 
the pattern in the swatch is incorrect after you 
insert  it, you can adjust it by moving the slider 
button or by typing in a new scale value. 

Changing Rotation 
Changing the rotation of the swatch is only rec‐
ommended for tiled swatches such as Paver, Stone 
and Deck Patterns.  It is best to manually type in a 
new angle for the exact rotation. 

Note:  It is not recommended to change the rota‐
tion of non‐tiled swatches, especially for clustered 
symbols like shrubs and trees.  These swatches 
will not fill uniformly.  

0° 

Figure 22—The effects of rotating a swatch  

45° 
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Removing color from an object 
Color can be removed from an object by using the undo button (to undo the last change) or by using the 
Remove Fill tool.  When  using the Remove Fill tool to remove color in the areas drawn with the polygon 
or circle tools,  the shape that is drawn will be removed as well. 

 
 

Copying Color Settings from one Object to Another 
When applying color to objects on a presentation you may come across a situation were you need to ad‐
just opacity, scale or rotation to a swatch that needs to be repeated for  other objects on the presentation as 
well.  Instead of being required to apply and then edit each object individually, you can use the Copy Fill 
and Shadows tool to copy these settings from one object to another. 

To use this tool, follow these steps (see figure 25): 

1.  Apply color to an object on the presentation and edit the opacity, scale or rotation and then click on the Copy 
Fill and Shadows tool.   

2.  Click on the object you wish to copy the properties from.  A thumbnail of the selected swatch will appear the 
left panel. 

3.  Click on any other object or area in the presentation that you wish to apply color with the exact same settings 
to. 

Figure 25—Copying fill properties 
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Adding Drop Shadow Effects 
 

The last step in creating that stunning presentation is adding the shadow effects to objects in the presentation.  
Shadows add depth to the presentation and improve it’s readability.  Shadows can be used to show which objects 
on the presentation are the largest or tallest and they can also be used to show grade changes such as steps and 
retaining walls.  

When should drop shadows be applied? 
Please note that shadows should only be applied at the very end of 
the coloring process.  Adding shadows will slow the performance 
of DS|Color, especially on larger drawings. 

 

Applying Drop Shadows to Colored Objects 
Adding drop shadows is very simple process: 

1.  Click on the Add drop shadows tool  

2.  Click on the object you wish to add a drop 
shadow to. 

Important note about drop 
shadows: 
Do not add any drop shadows until the 
very end of the coloring process.  Drop 
shadows will slow the performance of 
DS|Color.  Applying drop shadows 
should always be the last thing you do.  
It is also recommended that you save 
your presentation before adding shadow 
effects. 

Figure 26—Applying drop shadows 

Drop Shadows and the Layering Order 
It is important to have the correct layering order with objects you are adding drop shadows to.  If the layering 
order is not correct, shadows may not appear or they may be cut off.  Also, they may fall on the wrong objects 
giving a false impression of hierarchy of objects on the presentation.  After applying shadows you may need to 
use the layering order tool to make adjustments for the best results 

 

Changing the Drop Shadow Settings 
When you click on the drop shadow tool a Shadow Override panel will appear in the left panel below the 
swatches.  This panel will allow you to change any of the five settings for drop shadows.  Use the slider buttons to 



Color User Guide    21 

 

Tip: Using Drop Shadows Effects to Show Grade 
Changes 
Drop shadows can be used to effectively convey grade changes such as 
steps, retaining walls and pools.  Use the shadow override panel to adjust 
the direction and depth of the shadow to suit the grade change you are go‐
ing  to show.  You do not need to worry about using a light source direction 
that matches the majority of  other drop shadows used in the presentation, 
since these are strictly used to show a change in grade for the benefit of your 
client. 

Figure 27— Drop shadow to show a step 

Changing the Drop Shadow Defaults 
Each time you open the drop shadow tool the settings will return back to the program defaults.  If you wish to 
change these defaults to settings you prefer to use, follow theses steps: 

1.  Click on the View menu and then Options     

2.  In the Options panel that appears, select the Shadow Defaults tab 

3.  Change any setting you wish to be the new default by typing in the new value 

4.  Click Ok to save the new settings for the next time you use the Drop Shadow tool 

About Shadow Direction 
The default direction of the 
shadow is 0°.  If you enter a value 
greater than ‘0’, the drop shadow 
will move in a counter‐clockwise 
direction. 

Figure 28— Changing the drop shadow defaults 

change each setting: 
 

Direction:  Determines the side of the object a drop shadow will appear on.  The 
default direction matches the light source of the color swatches. 

Depth: Determines the length of the drop shadow 

Opacity: Determines how transparent the drop shadow appears 

Noise:  Increasing ‘noise’ will add a textured appearance to the shadow.  In‐
creasing noise is more suitable for the Pencil Crayon style swatches 

Softness:  Determines how defined a drop shadow appears without changing 
opacity  
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Printing and Exporting as an Image File 
 

Once your drawing is complete there are a number of options available to you: 

1.  Print directly from DS|Color to your printer 

2.  Export to a JPG or Adobe® PDF file to email to a client or send to a print shop for printing 

3.  Export as a PDF file and then print from PDF to your printer 

4.  Export as a PDF file to email to a client or send to a print shop for printing 
 

Important notes about printing 
 

� If you are printing from a computer that does not meet the recommended system requirements you may have 
difficulty printing larger colored drawings.  You may also experience problems exporting as a JPG.   

 

� It is not recommended to print to paper larger than ARCH‐D (24”x36”) size. The print file size may be too 
large for some printers to handle. 

 

� If you are experiencing problems, choose the smallest paper size that is appropriate for the drawing to reduce 
the chance of a problem occurring. 

 

� Using the PDF option is always a good alternative for anyone experiencing printing problem. 
 

� Always save your drawing before printing or exporting as a JPG. 
 

Please Note:  If you plan to print a lot of large colored drawings (D‐ and E‐size), consider upgrading your com‐
puter and your printer. 
 

 

 

Printing Directly from DS|Color 
To print a presentation directly from DS|Color, follow these steps: 

1.  Save your presentation to prevent any lost work  

2.  Click on the File menu and select the Print option 

3.  In the panel that appears select the printer you wish to print to print to 

4.  Next, click on the Preferences option to open your printerʹs preferences panel 
(Note: you do not need to choose preferences every time) 

5.  Choose the correct Orientation, Quality (color) and paper size (Note: if you wish 
to print your presentation to scale you must choose a paper size that matches 
your page size, which was originally set in DS|Design) and click OK. 

6.  Back in the Print Presentation panel, ensure the preview of shows the correct di‐
mensions and orientation of the paper you wish to print to. Click on the Print 
button if the settings appear correct. 

7.  A print status bar will appear until the presentation has been sent to the printer. 
This can take some time if the presentation is large. 
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     Note:  Larger drawings may take some time to print, so be patient. 
 

Exporting a Drawing as an Adobe® PDF or JPG (Email or Print Resolution) 
Exporting a drawing will provide several options: 

1.  Exporting as an Adobe  PDF will produce a good quality file that can be used 
to print from or that can be brought to a print‐house for printing (200dpi) 

2.  Choosing the Email Resolution option will reduce the size of the resultant 
JPG file so that it can be emailed to a client to review (96dpi) 

3.  Choosing the Print Resolution option will produce a higher quality JPG that  
can be used to print from, that can be brought to a print house for printing or used for marketing material. 

Want a higher Resolution? To change the resolution of the PDF or JPG click on the View menu and choose Op‐
tions. In the Options panel that appears, select the Print tab. Here you can adjust both the Print DPI and the Buffer 
size. For a detailed explanation about this panel see Changing the print resolution setting to improve printing 
performance on page 25 of this guide. 

 

About PDF Files 
Printing to a PDF file provides the same options as exporting to a JPG.  A PDF is a file type the both 
clients and print shops can open to view or print.  PDF’s provide excellent quality and can easily be 
printed to and from. 

Figure 29—Printing from DS|Color 
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Acquiring a separate PDF Writer 
You may wish to use a PDF writer/converter to create a PDF from your drawing. There are a number of PDF writ‐
ers that can be bought or downloaded for free.  It is important to find one that has architectural sheet sizes that will 
be needed for presentations larger than 11x17 (tabloid).  Here are two free PDF writers that are recommended: 

1.  CutePDF  (download free at:  http://www.cutepdf.com)   

2.  PDFCreator  (download free  at:  http://sourceforge.net/projects/pdfcreator  or directly from the  
    DynaSCAPE website at: http://www.dynascape.com/downloads/files/pdfcreator.msi 

 

How to Print to a PDF 
Printing to a PDF follows the exact same steps as printing to a regular printer, except that the end result is a PDF 
file as opposed to a printed piece of paper: 

1.  Save your presentation to prevent any lost work  

2.  Click on the File menu and select the Print option 

3.  In the print panel that appears select your PDF writer you wish to print to (installation of a PDF writer re‐
quired (see above) 

4.  Click on the Preferences option to open your printerʹs preferences panel 

5.  Choose the correct Orientation, Quality (color) and Paper size (Note: if you wish to print your presentation to 
scale you must choose a paper size that matches your page size, which was originally set in DS|Design) and 
click OK. 

6.  Back in the Print Presentation panel, ensure the preview of shows the correct dimensions and orientation of 
the paper you wish to print to. Click on the Print button if the settings appear correct. 

7.  A print status bar will appear until a Save As panel opens 

8.  Type in a name for the PDF , choose a location for the file and click Save 

9.  A PDF file will be created (This may take a few minutes if the presentation is  large) 

Once completed, the newly created PDF can be opened with a Adobe Reader® where it can be viewed or printed. 
This file can be shared with the client or sent to a print shop. 

Troubleshooting Printing 
 

My presentation drawing won’t print 
If you experience problems printing your presentation, there could be a number of causes: 

Cause # 1:  Your system does not meet the recommended requirements—crashes during printing 

Solution # A: Upgrade your system up to the recommended requirements—add more memory 

Solution # B: Switch to the Compatibility Mode and/or reduce print quality (see following page) 

Cause # 2:  Old printer drivers—nothing will print 

Solution # A:  Upgrade your printer drivers—go to your print manufacturer’s website and download and 
install the latest drivers available 

Solution # B: Switch to the Compatibility Mode and/or reduce print resloution (see following page) 

Solution # C:  Print or export to a PDF file and then print from the PDF file instead 

Solution # D:  Add more memory to your printer 
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My presentation drawing always prints to the wrong paper size 
Cause # 1:  Old printer drivers 

Solution # A:  Upgrade  your printer drivers—go to your print manufacturer’s website and download the 
latest drivers available 

Solution # B:  Switch to the Compatibility Mode (see below) 

Solution # C:  Print or export to a PDF file instead (see previous page) 
 

Switching to the Printer ‘Compatibility Mode’ 
You may need to resort to this option if you are experiencing problems printing: nothing comes out of the printer 
or you cannot change the paper size.  The printer ‘Compatibility Mode’ will force your printer’s drivers to accept 
your requested sheet sizes.  To switch to this mode, follow these steps: 
 

1.  Click on the View menu and then Options 

2.  In the Options panel that appears, select the 
Print tab 

3.  Click on the  Compatibility Mode  option to 
activate it and click OK 

 

Try printing the drawing again.  If this still does 
not work, try using the export or print to a PDF 
file instead (see previous page). 

 
Figure 30—Printer Compatibility Mode 

Figure 31—Print panel for Printer Compatibility Mode 

Printing Using the Printer 
‘Compatibility Mode’ 
When printing in printer ‘Compatibility Mode’ 
the print panel allows you to pick all the settings 
manually.  You will need to select three  settings: 

1.  Choose your printer from the list 

2.  Click on Preferences and choose paper size 
and orientation etc.  Click Ok. 

3.  In the Print panel, click Apply to apply your 
settings. 

Click Print and you should see better results. 

Changing the print resolution setting to improve printing performance 
If you are experiencing problems trying to print a presentation, it could be a result of a system that does not meet 
the  recommended requirements.  If adding more memory is not an option, you can try reducing the default resolu‐
tion setting that DS|Color prints out to or change the amount of memory  allocated to the printing process.  The 
default print resolution is 200DPI and most systems with 1GB  of RAM or more should not have any trouble han‐
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dling this level of resolution.  However if you are experiencing problems, you may wish to try changing the Print 
DPI setting and/or adjust the Buffer Size.  Follow these steps to change the default print resolution (DPI) and the 
buffer size: 

1.  Click on the View menu and then Options 

2.  In the Options panel that appears, select the 
Print tab 

3.  First try to use the Autodetect option—if 
your system requirements are low the Print 
DPI should change from the default of 200 to 
a lower number and the Buffer Size may 
change as well (the default Buffer Size is 256 

4.  You can also use your mouse to move the 
slider buttons to the left to reduce the print 
DPI or buffer size 

5.  Try printing again.  You may have to reduce  
the DPI further to print with your system 

Note:  Changing the Buffer Size can effect the quality of the output, mostly with larger sheet sizes and scales.   
Once  your system reaches your Buffer Size setting it will reduce print quality in order to continue the printing 
process.  You may need to test printing with different settings to get the best results and performance. 

Recommended Printers and Paper 
 
Choosing the Best Paper for Printing 
Standard bond papers can be used for printing in color, however using coated papers will 
produce the best results.  If you are using bond paper, a heavier weight is recommended 
(24‐28lb papers are ideal).  It is not necessary to use glossy papers as they are expensive, 
give off too much glare and take a long time to dry.   

 

Recommended Printers 
Printing large (Arch C & D) colored drawings requires a printer with a sufficient 
amount of memory.  The following is a recommended large format printer that 
will work well with DS|Color: 

 

� Canon imagePROGRAF iPF600 or 610—this is 24‐inch large format printer 
is the fastest out there and can handle large  print jobs.  This printer is new 
on the market and uses brand new technology.  This is your best option for 
printing from DS|Color.  Canon also has 36‐inch models available. 

Figure 32—Changing print quality 

About Reducing Resolution (DPI) 
If reducing DPI or Buffer Size does not a solve your printing issues 
or if the reduced quality does not meet your standards, upgrade 
your system to meet or exceed the minimum requirements. 
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Troubleshooting DS|Color 
 

1. The wrong objects keeps getting selected and colored: 
Problem:  Example: you are trying to color a tree and the swatch fills in the lawn or bed area instead.  This may 
be because the tree you are trying to color is on a layer beneath the lawn or bed.   

Solution: Use the layering order tools and move the object that keeps getting colored to the background 
layer 

2. An object won’t select or color: 
Problem:  An object on your drawing will not color.   This could be caused by a number of reasons: 

1.  The object is not ‘colorable’ ‐ it may not have a closed boundary 

Solution:  Draw a closed boundary for the object in DS|Design on the Color_Setup layer ,  save the drawing 
and then  use the Update Presentation option in DS|Color to update the drawing. 

2.  You are clicking on a line within the object, not open space 

Solution:  Zoom in and click on open space between the lines inside the object 

3.  The object was ‘exploded’ in DS|Design 

Solution:  Redraw or join them back together in DS|Design, save the drawing and then  use the Update 
Presentation option in DS|Color to update the drawing. 

3. A colored object disappeared and cannot be selected: 
Problem: You have colored an object and now others have disappeared—the objects won’t select because they 
are on a layer under the object that was just colored 

Solution:   Use the layering order tools and move the object that was just colored to the background layer 

4. A group of symbols colors as one object: 
Problem:  A group of figures colors as one ‘blob’ as apposed to individual figures—this will happen if the draw‐
ing is on older drawing and the figures were not created with the Color_Setup layer included. 

Solution:  Replace the figures on the DS|Design drawing with figures from the current version. 

5. I need to apply more than one color to a figure: 
Problem:  When you apply color to a figure such as a table and chairs, the entire object gets colored the same 

Solution:  In DS|Design, ‘explode’ the figure.  Now you will be able to color the chairs and table separately 

Problem:  When coloring an Aquascape pond, only the rocks will color 

Solution: In DS|Design, turn on the Color_Setup layer and draw a closed polyline inside the pond area to 
define the water.  You will now be able to color  the water and rocks different colors 

6. My text and leaders are hidden behind the colored objects: 
Problem:  You cannot see text or leaders under the color swatches 

Solution:  Zoom in close to one piece of text on the presentation and, using the Move to Foreground layer‐
ing tool, click on the lines of the text. All your text will be moved to the foreground. You may need to zoom in 
very close to the text in order to select it. 

7. My presentation won’t print 
See previous pages about troubleshooting printing issues 
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Customizing Styles, Categories and Swatches 
 

Although DS|Color comes with an ample selection of great color swatches, you have 
access to some simple tools that allows you to create your own.  The tool that allows 
you to  create new swatches, categories and even new styles is called the Style Editor 
and it is accessed through the DS|Color  Tools menu. 
 

The DS|Color Style Editor 
To open the Style Editor, click on the Tools menu and select Style Editor.  The style editor will open to the 
current style loaded in DS|Color.  At this point you have  three options: 

� Edit the current style ‐ add new swatches and categories or rearrange the swatches 

� Open one of the other existing color styles to edit them 

� Create a brand new style of your own 
 

Style Editor Components 

Figure 33—The DS|Color Style Editor 

Style Name     
Categories     
Swatches 
Add New Swatch Button 

Buttons for Moving  Swatches 
Swatch Preview 
Swatch Settings 
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Opening an Existing Color Style 
To open an existing style: 

1.  Click on the File menu and select  Open Style 

2.  You will need to locate one of the three styles.  They are found in the C: | Pro‐
gram Files | DynaSCAPE | Color | Styles  folder 

3.  Choose one of the three styles (they have the  file extension ‘.sty’) and click Open 

4.  The style will load.  It may take a few seconds for one of the styles with a lot of 
swatches.  You will be able to see all the categories along with their swatches. 

Once an existing style is open you have a number of options.  You can: 

� Change the order of swatches within a category 

� *Add/delete categories and swatches and add new styles 

� *Open existing swatches to revise their settings 

Note: If you wish add, delete or edit swatches in one of the DS|Color default styles, it is recommended to save 
the style as a new style and make the changes there. Periodically DynaSCAPE  releases new swatches and allows 
you to download them. By keeping your new or edited swatches in a different style will prevent them from 
being overwritten when the new swatches are installed. 

Changing the Order of Swatches in a Category 
You can change the order of swatches within a category to suit your preferences.  To 
change the order of swatches in a category, click on the category to view the swatches 
and use the arrows on the top right side to move them around.  You cannot change the 
order of the categories. 

Adding a New Style 
To add a new style click on the File menu 
and select New Style.  The screen will be 
blank with no categories or swatches.  To 
add swatches to your new style, follow 
these steps: 

1.  Create a category first by clicking on 
<New Category> 

2.  Type in a new name for the Category 

3.   Add swatches  to the category  as 
needed 

Deleting a  Style 
Deleting a style cannot be done from the Style Editor. To delete a style: 

1.  Close DS|Color 

2.  Open  Windows Explorer (My Computer)  

3.  Navigate to C:\Program Files\DynaSCAPE\Color\styles 

4.  Delete the style you wish to remove.  

5.  Open DS|Color and the style deleted will no longer be in the list. 
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Solid—solid color swatches allow you to select a specific solid color.  This swatch type was only 
used in the Contemporary Style.    

Adding a New Custom Swatch 
Adding new swatches into DS|Color is a relatively simple 
process.  If you would like to have more swatches in any of 
the categories or if you have your own style you would like 
to use, follow the steps outlined on pages 31—33 in this 
guide. 

 

There are four types of swatches that you can choose to add, 
two of which are for more advanced users and will not be 
outlined here.  These can be selected by clicking on the New 
button located above the swatches: 

Linear Gradient—this type of swatch allows two or more colors to fade into each other from 
one direction.  This swatch type was only used in the Contemporary Style. 

Radial Gradient—this type of swatch allows two or more colors to fade into each other from 
the center.  This swatch type was only used in the Contemporary Style. 

Texture—this is the most commonly used swatch in all the Color Styles.  This type of swatch is 
created from an image file such as a JPEG, TIF, BMP or PNG.  This is the type that will allow you 
to create your style starting with your own hand colored swatches and turning them into digital 
swatches. 

Figure 34—Choosing a new swatch type 

Downloading New Swatches from DynaSCAPE 

Periodically, DynaSCAPE  releases new swatches and allows you to download them.  They will be available from 
the My Account page of the DynaSCAPE website (www.dynascape.com). 

Please note, if you wish add, delete or edit swatches in one of the DS|Color default styles, it is recommended to 
save the style as a new style and make the changes there. By keeping your new or edited swatches in a different 
style will prevent them from being overwritten when the new swatches are installed. 

Adding/Deleting a New Category 
To add a new category: 

1.  Click on the Edit menu and select Add Category.  

2.   Highlight the name <New Category> and type in a new name.   

3.  Now you can add swatches to this category. 

To delete a category: 

1.  Highlight the category name, go to the Edit menu and select Remove 
Category. 
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Creating a Solid Color Swatch 
To create a solid swatch click on the New button and choose the  Solid option.  Next, follow these steps: 

1.  Open an existing style or create a new one (see page 29). Choose a category for the new swatch 

2.  Move the Red, 
Green and Blue 
slider buttons to 
determine your new 
color 

3.  Set the opacity 
(transparency) of the 
swatch if you wish 

3.  Type in a descriptive 
name for your new 
swatch 

4.  Click Update to save 
the new swatch.  Before closing the Style Editor, go to the File menu and choose  Save Style  

Figure 35—Creating a solid color swatch 

Creating a Linear Gradient Color Swatch 
To create a linear gradient color swatch click on the New button and choose the  Linear Gradient option.  Next, 
follow these steps: 

1.  Open an existing style or create a new one (see page 29). Choose a category for the new swatch 

2.  Select one of the two default Gradient Stops to set the color for each Stop 

3.  Move the Red, Green and Blue slider buttons to determine your new color for the gradient 

4.  Click Save to save the setting for the gradient and do the same for the second gradient stop (more stops can be 
added if you wish) 

5.  Use Start Set to set the angle of the gradient.   

6.  Type in a descriptive name for your new swatch and then click Update to save the new swatch. Before closing 
the Style Editor, go to the File menu and choose  Save Style  

Figure 36—Creating a linear gradient color swatch 
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Creating a Radial Gradient Color Swatch 
To create a radial gradient color swatch click on the New button and choose the  Radial Gradient option.  Next, 
follow these steps: 

1.  Open an existing style or create a new one (see page 29). Choose a category for the new swatch 

2.  Select one of the two default Gradient Stops to set the color for each Stop 

3.  Move the Red, Green and Blue slider buttons to determine your new color for the gradient 

3.  Click Save to save the setting for the gradient and do the same for the second gradient stop (more stops can be 
added if you wish) 

4.  Use Center and Origin to set the `light source` of the gradient and then type in a descriptive name  

5.  Click Update to save the new swatch. Before closing the Style Editor, go to the File menu and choose  Save 
Style  

Figure 37—Creating a radial gradient color swatch 

Creating a Custom Texture  
This is the type of swatch that most of the swatches in DS|Color are made with.  The process to create your own is 
surprisingly simple.  You can create one from any JPG image or you can start with a hand‐drawn texture and then 
turn it into a swatch:   

1.  On a piece of paper draw two to three inch square 

2.  Using marker, pencil crayon or any other medium color a swatch inside this square  

3.  Scan it and save it as a JPEG file  

4.  Crop the scanned image to just inside the drawn square 

5.  Follow the next steps:  Adding a Texture as a New Swatch   
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Important: Saving a New Swatch or Style 
Before closing the style editor, save the style that has been changed. 

All styles must me saved in this location on your computer:    C:\Program Files\DynaSCAPE\Color\styles 
(Note: ‘C’ is the default drive Color is installed on—use the correct drive letter that your program is installed on if 
necessary e.g. ‘D’ or ‘E’) 

Any time you save a style, all your new swatches will have their corresponding images (texture files) copied into 
the following folder:    C:\Program Files\DynaSCAPE\Color\styles\textures 

If you are adding new swatches to an existing style it is recommended that you use the ‘Save Style As’ option un‐
der the File menu to save the style as a new one.  This way you can identify any styles that have been customized. 

If you are creating a new style use the ‘Save Style’ option under the File menu and save in the correct folder note 
earlier.   
 

 

Testing and Using Your New Styles or Swatches in DS|Color 
To use your newly created styles and/or swatches you first need to save the style before closing the style editor by 
clicking on the File menu and selecting ‘Save Style’. When you close the Style Editor, the Style you had open in the 
Style Editor will reload in DS|Color to update the changes you have made. Any new swatches you made will be 
available for testing. 

Adding a Texture as a New Color Swatch  
To add this new texture image as a swatch in DS|Color click on the New button and choose the  Texture option.  
Next, follow these steps: 

1.  Open an existing style or create a new one (see page 29). Choose a category for the new swatch 

2.  Under texture properties click on the Browse button to locate the image file you wish to use 

3.  If the texture is a repeatable one (i.e. paver pattern, grass pattern etc.) choose the Tile option 

3.  Type in a descriptive name. 

4.  Click Update to save the new swatch.  Before closing the Style Editor, go to the File menu and choose  Save 
Style 

Figure 38—Creating a texture color swatch 
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New For opening a new DS|Design drawing for coloring 

Open Presentation For opening a presentation that has been saved in DS|Color 

Save Presentation For saving the current presentation in DS|Color 

Save Presentation As For saving the current presentation in DS|Color as a new name 

Pack Presentation For saving a presentation along with all the color swatches and any rasters 
used in the presentation in order for it to be opened in a version DS|Color  
that may not have all the same swatches 

Unpack Presentation For  unpacking a presentation that has been packed with all the color 
swatches and rasters 

Export Adobe PDF:  For saving the presentation as a PDF file at a resolution suit‐
able for printing.  The original sheet size is maintained. 

Email Resolution Image:  For saving the presentation as a JPEG to a size 
suitable for emailing to a client for review.  The size and resolution is re‐
duced. 

Print Resolution Image:  For saving the presentation as a JPEG at a reso‐
lution suitable for printing.  The original sheet size is maintained. 

Print For sending a presentation to a printer or PDF writer 

Exit Closes DS|Color 

Update Presentation For updating changes made to the DS|Design drawing (NEW for v2.0) 

The File Menu: 

Undo For undoing the last command(s) 

Redo For redoing the last command(s) 

The Edit Menu: 

Options Opens the Options panel for the default settings for swatches, shadows, print‐
ing and performance 

The View Menu: 

Style Editor Opens the Style Editor tool for modifying and creating new styles, categories 
and swatches 

The Tools Menu: 
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 For copying swatch settings (opacity, 
scale, rotation and shadow) from one 
object to another. 

 For editing opacity, rotation, scale and 
bleed of a selected swatch 

 For removing color from a swatch well 
as the polygon or circle from the presen‐
tation that were drawn in Color. 

 For adding drop shadows to objects on 
the presentation 

 For drawing circles to which color can be 
applied 

 For drawing polygons to which color can 
be applied 

 Object layering tool—for moving objects 
to the foreground (the top layer) 

 Object layering tool—for moving objects 
one layer forward 

 Object layering tool—for moving objects 
to the background (the bottom layer) 

 Object layering tool—for moving objects 
one layer backward 

 For opening a new DS|Design drawing 
for coloring 

 For opening a presentation that has been 
saved in DS|Color 

 For saving the current presentation in  

DS|Color 

 A zoom tool to fit the entire presentation 
into the workspace of the program win‐
dow 

 A zoom tool that allows you to use a 
selection window to zoom in on a spe‐
cific area in the presentation.   

 A zoom tool that will zoom in to 50% of 
the current view 

 A zoom tool that will zoom out to 50% of 
the current view 

 For undoing the last command(s) 

 For redoing the last command(s) 

 For applying color to an object.  Auto‐
matically sets when you click on a color 
swatch  

The DS|Color Toolbar: 

About For viewing your version number of DS|Color 

Welcome Screen Opens the Welcome Screen giving access to the Color introductory videos 

The Help Menu: 
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Version: 2.0 Date: 2/12/2009 

Thank you for choosing a DynaSCAPE software product.   You have joined thousands of businesses that rely on 
DynaSCAPE every day to help them run their business in a professional way.  We are committed to helping you 
spend less time with old‐fashioned and inefficient systems and spend more time on your business.  

 

Products: 1.800.710.1900 or www.dynascape.com 

 
 
This CAD software is perfect for the Landscape Designer or the Design/Build Contractor looking for professional 
software . It includes a full‐featured 2‐D CAD functionality with a built in customizable plant list that connects to 
DynaSCAPE’s Online Plant Database. Design also integrates with DynaSCAPE Manage, a powerful estimating and 
business management tool.  Check our website for more details. 
 
 
 
This is the ultimate presentation tool that adds full color to your DS|Design drawings. DS|Color is a separate mod‐
ule that provides all the tools needed to turn a DynaSCAPE drawing into a colored masterpiece that looks like it 
was colored by hand.  Check our website for more details. 
 
 
 
Introduce your business to the most powerful estimating, business management and job costing software for the 
green industry.  Built specifically for the landscape professional, DynaSCAPE Manage consolidates your entire 
business into one software package. Check our website for more details. 
 

 

 

Draw your site plan with a handheld device (PDA). SiteCapture Pro is the first mobile site drawing tool of its kind 
to offer both time savings and improved accuracy to any landscape designer who needs to measure property 
boundaries and record their dimensions.  Site measurements are entered directly into a PDA and then imported 
into DS|Design to become a base plan. Check our website for more details. 

 
 
 

The leading source of horticultural information software for the Green Industry since 1991. Horticopia Professional 
software contains detailed cultural data and full color images for thousands of plants. It allows you to view plant 
pictures and information for a single plant or a group of plants and find, organize, and manage plant information 
and lists. Check our website for more details. 

For our full line of products visit our website: www.dynascape.com  




